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Dennis Koble and
Lee Actor

Lee Actor and Dennis
Koble formed

PGA TOUR®GOLF Il

Polygames in 1988 to
bring together their
diverse talents for
creating
entertainment
software. With thirty
impressive software
titles to their credit,
we think PGA TOUR
GOLF 11 is their best
eftort vet.

Lee and Dennis are inveterate golfers, who try to hack
their way around the local courses at least once every
week or two. They'd like to tell you they’re scratch
handicappers, and they are—as long as they're playing
PGA TOUR GOLF I1.

IWARNING
To Owners of Projection Televisions!

STILL PICTURES OR IMAGES MAY CAUSE PERMANENT
PICTURE-TUBE DAMAGE OR MARK THE PHOSPHOR OF
THE CRT (TELEVISION SCREEN). AVOID REPEATED OR
EXTENDED USE OF VIDEO GAMES ON LARGE-SCREEN
PROJECTION TELEVISIONS.




A

Selects a high-
lighted menu
option. Confirms
(OKs) a choice.

A

Selects or
confirms a
menu choice.

On the tee, displays
the Overhead

view.

On the grass-or in
the sand, shows
Ball Lie.

On the green,
shows the Green
Grid.

Toggles options
from Setup menu
on/off.

B

Press B three
times to strike
the ball.

Toggles options
from ScluP
menu on/off.

e
Cancels menu
selection.

e

Hold C to displa
the draw/fadg 3
meter. (Press
D-Pad L/R to
adjust draw/
fade.)

Cancel menu
ion.

Start

Activates /Deactivates
menu bar. Cancels
menu selection.

Start
Activates/Deactivates
menu bar. Cancels
menu selection.

Clears Ball Lie
window and
Overhead view.

D-Pad
Left/Right displays
different menus.

Up/Down highlights
menu items.

D-Pad
Left/Right moves
aiming cross-hairs.
UP/ whn selects
different club.

Highlights pull-down
menu items.

There are additional commands governing the Green
Grid and the Hole Browser. Please see those sections
in the manual for more information.
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WELCOME TO PGA TOUR® GOLF Il

PGA TOUR
® ¢ GOLFI

PGA TOUR GOLF II offers everything contained in the
original PGA TOUR GOLF, and plenty more besidés. You'll
find three new golf courses, a precise “Draw/Fade” control, a
“skins” contest format, expanded statistics, and a new user-
controlled fly-by option called the “Hole Browser”. Also,
you'll notice clear improvements in the graphical and audio
presentation of the game,Ifyou’re familiar with the first PGA
TOUR GOLF, you can probably play the game using little
more than the gommand summary chart at the front of this
manual. But#fyou'd like to excel more quickly, you'd do well
taconsult the Basics from the House Pro and Fine Points from the
Master sections on page 10 and 17. So, without further adieu,
let's get out on the course.



= SPORTS

1. Turn éFF the power switch on your Sega™ Genesis™.

Nev:
is on.

rt or remove a game cartridge when the power

2. Make su]&’onh‘oller is plugged into the port
labeled Control 1 on the Console.

If you want to use
p-58.

ntrollers, see Using 2 Controllers,

3. Insert the game cartridge ifito the slot on the Genesis.
Press firmly to lock th idge in place.

4. Turn ON the power switch. =

4
The EA SPORTS logo will appear. If you don'’t see it, begin
again at step 1.

5. The PGA TOUR GOLF I title schpears, followed
immediately by the game credits screen.

If you want to play right away, press Start to ge to the Pro
- j

6.  Press Start to bring down the Play Menu.

s (I

7. Practice Round is automatically highlighted. Press A to
select Practice Round.

8. The Select Number of Players box appears. D-Pad left/right
to highlight desired number of players, and then press A.

9. New Player is highlighted automatically. Press A.

10. The Players Card appears. D-Pad up/down to select letters
and left/right to enter letters and move the cursor. When
you've successfully entered a name, press Start.

11. The Tee Selection box appears. D-Pad left /right to select
your tees, and then press A.

12. The Club Selection box appears. If you wish to substitute
one or more clubs, follow the on screen instrug or see
page 44. Press A to continue. You will need to repeat steps
9-12 for each player. :

13. The Select Course box a . D-Pad up/down to

highlight a course A to select it. In a moment
you will find yourself on the first tee of that course. See
below for. ions on how to golf.

9
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BASICS FROM THE HOUSE PRO

aiming cursor,

flag otick name of

current
golfer

currenl
score
(even)

| distande
to cup

wind club’s distance shot  current
meter  potentialat 100% type  club

The information below is essential for good play.

THE ACCURACY POINT

/ accuracy point

power bar

backswing
stopped

10

v

['he most important skill to develop in PGA TOUR GOLF II is
stopping your swing exactly on the accuracy point. If you
miss the accuracy point to the right, the ball will slice to the
right. If you miss the accuracy point to the left, the ball will
hook to the left. The greater your distance from the accuracy
point, the greater the degree of the hook or slice.

* Press B to start your backswing, press B to stop your

backswing and begin your swing, and then press B to
strike the ball (at the accuracy point).

marker

You might want to hook or slice the ballto get around a
corner or avoid a hazard. The best way to control a hook or a
slice is to set the “draw/fade” meter before you swing the
club, and to hit the accura€y point as usual. It's not advisable
to employ draw or fade when your ball lies in the heavy
rough or the sand. The draw /fade meter is not available
when you're‘putting. (See page 14 for more on draw and
fade.)

* Press and hold C to bring up the draw/fade meter. D-
Pad left/right to adjust the draw/fade marker.

1"
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The computer automatically selects a club for every situation,
but you don’t have to use that club.

* D-Pad up/down to change club selection.

The name of the selected (Mppears at the bottom of the
information box in the lower right corner of the screen. Each
club has different characteristics (see page 13 for more on club
selection), the most important of which is it’s maximum
distance potential. A clubs max distance potential
accounts for the ball lie, and assumes landing and rolling on
the fairway. Is does not indicate “distance in the air”. The
maximum distance potential of a club gwn at the left side
of the stroke meter.

9
12 J

The wind indicator is located at the bottom left
corner of the screen. The wind effects all shots
except for putts. When the arrow is pointing up,
the wind is blowing from your back and will
add distance to your shot. When the arrow is
pointing down, the wind is blowing into your
face and will reduce the distance of your shot. When the
arrow is pointing right or left, the wind will blow your shot to
the right or left respectively. Of course, the stronger the wind,
the greater its influence over the shot.

medium iron

long iron

o3

|
120 'yldl 180 ;.dl 240 yards

Note: The short irons impart a greater arc to the shot
than do the woods and long irons. Consequently, the
higher the arc of the shot, the more the wind will
influence the flight of the ball.

13
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é ADJUSTING YOUR AIM
The flashing cursor at the center of the screen indicates the

duecnm which the ball will travel immediately after you
s

in the optimum position for a straight shot with no wind. On
all subsequent shots, the computer places the aiming cursor
directly in i th the pin, regardless of whether the pin is
visible on the screen. It's always up to you to compensate for
the wind, either by using the draw/fade meter, or by
adjusting your aim, g

When you're faced with an obstacle or hazard that prohibits
you from aiming straight at the pin, you'll find it useful to go
to the hole browser for an elévated look at the problem. Once
you learn to use the draw/fade meter in conjunction with the
aiming cursor and the wind, bending your shots around
corners becomes an exciting ¢

* D-Pad left/right to adjust the aiming cursor.

Hitting the accuracy point won't help you if you don’t
measure your shot correctly. The distance of shot is
determined when you stop the power bar i backswing,

In order to decide where to stop the power bar, you have to

do a little quick arithmetic.

tee shots, the computer places the aiming cursor

F=aYSPORTS

For example, let’s say your ball is lying cleanly on the fairway
120 yards from the pin. The computer selects the nine iron,
which in this circumstance has a distance potential of 131
yards. The wind is blowing across the fairway to your right at
15 mph. Before you hit the ball, you'll want to move the
aiming cursor to the left several increments to compensate for
the wind. Now you have to decide how far up the stroke
meter you want to let the power bar run before you stop it.
First consider that 120 yards is roughly 90% of 131 yards.
Then realize that the strong crosswind is going to slow up the
ball, and that the ball will actually have to travel farther than
131 yards to reach the pin since your aim is to the left of
center. Finally, account for a certain amount of backspin on
the ball. (See page 24 for more on backspin.) In the final
analysis, it's probably best to stop the power bar justa hair
shy of 100% and, of course, hit the accuracy pointright on the
button.
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FINE POINTS FROM THE MASTER

backswing stopped in
overswing area

ball in cup

The area to the left of the 100% mark on the stroke meter is )

called the “overswing area”. If you venture into the If you really want to get good at this game, you have to be
overswing area, you can actually hit the ball farther than the aware of all the factors that can influence the outcome of a
maximum distance listed on the stroke meter. But if you don'l given shot.

hit the accuracy point, the results can be costly. Any hook or BALL LIE

slice will be magnified according to how far into the
overswing area you actually went. Hitting the accuracy point
becomes especially important when you'decide to pull out all
the stops.

There are seven surfaces where the ball can
lie: tee, fairway, green, fringe, rough, heavy
rough, and sand. The latter four surfaces
pose unique problems for the golfer. First,
let’s talk about the more desirable surfaces.

) * Press A when not on the tee or the green to see the
ball lie.

16 17
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The Tee—Every hole begins at the tee. All you have to
‘about here is the wind, the aiming cursor, and your ability
hit the accuracy point.

The Fairway—When you're not on the green or the fringe, i

best to be on the fairway. Occasionally, you'll find your
“in a depression” on the fairway. No, we're not talking a
a black mood.men your ball is in a depression, the

maximum distance for a given club is slightly reduced, and

the possibility of a wild shot increases if you decide to use
wood or a long iron.

The Green—Knowing how to read a green is essential if
want to shoot low scores. The computer allows you to use
only the putter, and the wind is not a factor. (See page 25-
for a full description of the Green Grid controls.)

The Fringe—The dark green area surrounding each green
called the fringe. Here you can choose the putter or any
club. If you're using the putter, make sure to strike the ball
extra-hard when there’s a lot of fringe to putt through.
there’s only a little fringe to putt through, the fringe will ha
little effect on the putt. On long shots from the fringe, you
might want to try a chip shot. (See Special Shots on

page 20-24)

The Rough—The rough reduces the maximum distance
potential of whatever club you select, and it increases the
effect of a hook or slice. Even if you strike the ball exactly
the accuracy point, your shot might hook or slice a bit. If

18

ball winds up “Half-buried in the Rough”, the maximum

distance potential of the clubs is further reduced, and the

degree of hook or slice becomes even more unpredictable.
Also, there’s a chance that you'll flub the shot altogether,

especially if you choose a wood or a long iron.

The Heavy Rough—As you might expect, the heavy rough is
more undesirable than the ordinary rough. Here, the distance
potential of the clubs is further reduced, and the outcome of
your shot becomes even more unpredictable. It can be
dangerous to attempt a long shot from the heavy rough. If
vou find yourself “Half-Buried in the Heavy Rough”, you
must exercise even more caution. Nowhere is the “flub”
factor more ominous. Also, we suggest that you not use the
draw/fade meter when you're hitting from heavy rough.

)
The Sand—At all costs avoid the sand traps, especially the
ones along the fairway. It's very difficult to make an accurate
long shot from the sand. The distance of your clubs is greatly
reduced, and the chance for a wild hook or slice is greatly
increased. When your ball is “Half-Buried in the Sand” the
program will almost cena‘iﬂy select the sand wedge, which is
the best club for scooping the ball out of the sand. Using a
longer club (such as a one or two iron) to get greater distance
is risky, as there’s a good possibility of flubbing the shot with
a flat iron. We advise against using the draw /fade meter
when you're lying in the sand.

On short shots from the sand, the ball will roll forward after it
hits the green. The number on the shot meter indicates the

19
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distance the ball will travel before it lands, so you should Normal Shot
measure the shot so that the ball lands well in front of the I'he normal shots are “drive”, “shoot”, “pitch”, “blast” and
cup. The longer the shot, the farther the ball will roll after it putt”. You “drive” from the tee. You “shoot” when you're
lands on.the green. far from the pin on the fairway, rough, or heavy rough. You
‘pitch” when you're close to the pin on any surface. You
SPECIAL SHOTS blast” when you're in a sand trap. You “putt” when you're

on the green or the fringe. But bear in mind that, whenever
you're not on the green, you can elect to “chip” or “punch”
the ball.

Your ball lie and your distance to the cup should determine
your shot selection. Normally, the program decides the best
shot-type for your situation, but you might not agree. To
change the shot-type, you have to go up to the menu bar.

* Press Start to highlight the menu bar. D-Pad right to
display the shot menu. D-Pad down to highlight the
shot you wish to perform, Press A to select that
shot-type.

Chip Shot

Normally, you'll use a chip shot when you're close to the pin
but not on the green. The maximum distance of a chip shot is
52 yards (that being with the driver), but you really shouldn’t
chip from that far out. The number on the shot meter
indicates the total distance of the shot after the ball lands on
the green and rolls to a stop. Be sure to check the Green Grid

20 21
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before you chip the ball, and keep in mind that the ball will bg Punch Shot

airborne over the nearest part of the green on a short chip. 'he punch shot should be used exclusively for “half-buried”
The standard rule of thumb when chipping is that the ball and “buried” situations. You have to gi\'c'up some distance
will travel in the air approximately half the club’s total vhen you punch the ball, but the chances of flubbing the shot
distance potential, and it will roll the other half of the way, re gréatlv reduced. Be aware that the program will never
depending on the slope of the green of course. elect thc-punch shot for you, so when you find yourself

buried in the sand or half-buried in one of the rough surfaces,
t's up to you to select the punch shot.

flag stick

extreme hook

22 23
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there’s a chance the ball will stop on the green after the first
bounce, if the green is large enough.
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Fringe Putt

Remember that when you're on the fringe you don’t have to
putt the ball. The program will always select the fringe pult,
but if you'd rather chip, pitch, or punch, you can choose to do
s0. Now, if you change your shot type and then change your
mind, you can select “Fringe Putt” from the shot menu.

THE SECRET TO PUTTING

The green grid provides two critical pieges of information: the

elevation of the ball with respect to the eup, and the contours
ROLL AND BACKSPIN of the putting surface. The distance between the ball and the
cup is listed in both the info box on the golf course screen and
on the putting grid screen. If the ball is more than a few

fringe

When aiming for the green, you'll want te.account for the

amount of roll or backspi > ball. i : i

ot fhis o il Al H\F:l:‘e(;lnut;:lbjls:o: 3_"" bad;SP"; only inches above the cup, you'll want to hit it softly. If the ball is

s e ¥he e E off(:h :ron g" kl?n.y more than a féew inches below the cup, you'll want to hit it
5 y or € tee. Dackspin extra hard. With practice, the strength of your putt will

takes effect after the first bounce. The ball hits the green,
bounces forward, then grabs on the second bounce and rolls
backward. If you hit the green with a wood fre / i

h e o R4 ) far awas * Press A when on the green to see the green grid. Press
the ball will rocket off the putting surface into the rough or button to return to golf cours

sand beyond. If you hit the green with a medium or long i iy ey v i

begcome second nature.

24 25
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NOTE: You can access the green grid from the View

F menu when you're not on the green as long as you're
ey within 39 yards of the cup.

* D-Pad up/down to rotate the grid left/right.

It’s reading the breaks of a green that poses the greatest
problem. When the lines that form the boxes on the grid are
unbroken, the green is as flat as a pool table. When the

is absolutely flat, you need only putt the ball with the p
strength, and hit the a cy point perfectly, to sink it.

the squares betw Il and the club are broken
downward to the left, the green is sloped to the left. If the
squares are broken downwatq to the right, the green slopes
to the right. You have to co te for these slopes with
aiming cursor if you want | Il to have a chance of falli
into the cup.

* D-Pad left/right to move the cursor left/right.
NOTE: Unlike in the Overhead View, when you

reposition the cursor on the green grid screen, it remains
to the golf course.

in that exact position when yo
There is no hard-and-fast rule for determining just how m

improve with practice. Below are a few reliable rules of

thumb.

to compensate for breaks in the green, but yo g’l] certainly

1. The breaks in the green effect the ball more as the ball
slows down. This means that it's more important to
compensate for the breaks around the cup than for those
directly in front of the ball.

2. When compensating for a drastic break, keep in mind
that the ball will be traveling farther to the cup since it's
not following the straight path between two points. In
such a case, make sure you add a little distance to the
putt.

3. Particularly on short putts, it's generally a good idea to
hit the ball too hard rather than too soft. Don’t try to cozy
in your short putts.

%Y
NPy
e
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VIEWING THE COURSE v

We've already covered the Ball Lie View and the Green View,
Another important view is the Overhead View.

OVERHEAD VIEW
water  your ball  heavy rough  sand
S
yreen
-8
™~ cursor
]
A
> rough

distance to cursor

The Overhead view is best used in.measuring long shots,
particularly when there are hazards or trees involved.

When you're on the tee,
* Press A to bring up the Overhead view.
* Press any button to return to the golf course.

When you're between the tee and the green,
* Press Start to highlight the Menu Bar.
* D-Pad right to View (Overhead is already highlighted)
* Press A.
* Press any button to return to golf course.

28
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When in the Overhead view screen, you can move the cursor
with the D-Pad to measure the distance between your ball
and any other spot on the course. In this way, you can
determine exactly what you need to do to put the ball just
where you want it.

NOTE: Unlike the green grid view, when you reposition
the cursor on the Overhead view the change is not
reflected on the Golf Course screen.

BALL LIE

Ihe Ball Lie window shows you what kind of terrain your
ball is resting on. See page 17-20 for more about the different
ball lies.

* Press A (unless you're on the green) to check your
ball lie.

GREEN

When you're on the green or within 40 yards of the cup, you
can access the green grid to.check out the contours of the
putting surface.

* Press A when you're on the green to see the green grid.

» Select Green from the View menu when you're near the
green to see the green grid.

29



FLY-BY HOLE PREVIEW

The Fly-By Hole Preview appears at the beginning of every
hole. It not only gives you a sweeping aerial view of the hole,
but a pro appears on the screen and offers advice on how to
play the hole. This feature is particularly useful for beginning
players.

* Press Start to bypass the Fly-By Hole Preview, or go the
Setup box in the Options menu to deactivate it.

30

A

HOLE BROWSER

he Hole Browser provides a user-controlled fly-by of the
entire hole and offers much more detail than either the
Overhead View or the Fly-By Preview. This can be very

seful on your approach shot, so you can see exactly where
the hazards and obstacles are positioned in relation to the cup

nd to your ball lie.

* Select Hole Browser from the View menu.

* D-Pad up/down/left/right to browse the hole.
* Press B to switch views.

* Press C to resume game.

* Press Start for Help instructions.

31
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INSTANT REPLAY

: é}he program automatically shows an instant replay after an
- outstanding shot, but you can replay any shot you like,
one ma/g by a computer-operated pro.

* Press A to confirm your choices.

Auto Overhead appears before your shot every time the ball
is more than 100 yards from the hole.

Auto Ball Lie appears before your shot whenever the ball lies

* Select Instant Replay from the View menu.
between the tee and the green.

* PressA.

i RRE ™ Ve Auto Greens appears before your putt, whenever the ball is

on a green or within 39 yards of the hole.

- AUTD-VIEWS
R
i

Auto Fly-by Hole Preview appears at the beginning of every
hole, before you tee off.

* Press Start to bypass any view. w‘ﬁ

¥
I

9

You can set the program to automaﬁc&how any or all of
the views at the appropriate time(s).

¥

* Select Setup from the Options menu either at the PGA
Tour Tent or on the golf course.

Pt

A

* Highlight the feature you wish to activate or deacti

and press B. 1
» v
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STATS
PGA TOUR GOLF 11 offers a variety of stats.

* Select any of the Stats from the Stats menu.

CURRENT PLAYERS

This screen shows the complete stats of all the players
currently in your party. The program keeps the stats for up to
16 saved human players and all the comiputer controlled pros.
A players stats are updated every time s/he plays in a
tournament or a skins challenge, but not in practice rounds.

Reset Stats

You can reset a human player’s stats only from the Current
Players stats screen. (See screen). You can reset all the pros
from the Options menu on the PGA Tour Tent screen. You

34
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can reset one or more pros individually from the Current
I’layers stats screen if they are currently in your party.

Some of the stats (Longest Drive, Earnings, Best 18 holes, etc)
ire self-explanatory. Below is an explanation of the statistical
categories that might not be so obvious.

Driving Acc. stands for “Driving Accuracy.” An accurate
drive is one that stops on the fairway or the green. This stat
‘hows the percentage of times the player drives the fairway
or the green.

Greens in Reg. stands for “Greens in Regulation.” On a par 3,
the ball must lie on the green after your drive to be
considered on the green in the regulation number of strokes:
On a par 4, the ball must lie on the green after your second
shot. On a par 5, the ball must lie on the green after your third
shot. The stat shows the percentage of times the player makes
the green in the regulation number of strokes.

Putts/G.LR. (Greens in Regulation) is the average number of
putts it takes you to sink ghe ball in the hole when you reach
the green in the regulation number of strokes. Ideally, a golfer
should reach the green in regulation and putt no more than
twice to hole'out. Reaching the green in regulation and “two-
putting” is the standard recipe for “par”. The stat here shows
the average number of strokes it takes for the golfer to hole
out when he reaches the green in regulation.

35
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Par Breakers are those holes in which a player beats
(‘breaks”) par. The stat here shows the percentage of times
the player breaks par.

Par Sayes are those holes in which a player shoots or breaks
par without making the green in regulation.

Avg. Par stats indicate the average number of strokes a playet
takes on the par 3s, 4s and 5s, respectively. '

* Press C to exit.

The tournament stats begin with a list of Leadig Money

Contests counts equally with money won in tournaments.

Winners ranked in order of earnings. Money won in Skins '

36
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ext to the earnings column is the “Won” column, which
dicates the number of tournaments each player has won.
lext to the “Won” column is the “Top 10” column, which
dicates the number of times each player has finished in the
p ten. Next to the “Top 10” column is the “In Money”
lumn, which indicates the number of times each player has
nished a tournament in high enough standing to collect

yme of the purse. Generally, the top 32 players in a
yurnament each receive a piece of the pie.

* Press A to page rapidly through the list.

\fter the Leading Money Winners comes the list of Leading

orers, ranked in order of lowest average score for 18 holes.

Next to the “Average” column is the “Best 18" column, which

sts the best score each golfer has recorded on an single
ound of 18 holes. Next to the “Best 18” column.is the “Best
2" column, which lists the best score each golfer has

ecorded for an entire tournament.

* Press Start to return to the golf course or PGA TOUR
Tent.
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SCORECARD
4141213133 [3]2]4]28
red Couples{ 4 |S |2 [3[a]6[a2[¢ ]38
I THOHROODHBEES
aul 4141213[6]5]3[3]6]36
[] 3J21313[3]213126 [-18
red Couples{ 4 |2 [a [3[a[S5[612]5]137 -1
wzzy Zoeler 4 [ @ [3]a]5(6(3]|5(38 |+2
aul 4171514 la]5]5]2]5]4a1[+5

The scorecard appears after every hole in a tournament or
practice round. You also can aecess the scorecard from the
Stats menu. The scorecard im#ournaments and practice
rounds shows the name of the course you're playing on, the
names of the players in your party, and all 18 holes. Beneath
the number for each hole is the distance of that hole in yards,
from tee to green. Beneath the yardage of the hole is the par
requirement for the hole. Each player’s score on a given hole
is entered into the box across from his name beneath the
applicable hole number. Par scores appearin blue. Scores
lower than par appear in red. Scores higher than par appear
in black.

In the Skins Challenge, the scorecard shows only the names of
the players, the number of skins won, the amiount of money
won, and the stroke total on the current or most recent hole)
(See page 53 for more on the Skins Challenge.)
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S Flanagan 7 $190,000 0+
Mark McCumber 2 $50,000 0+
Bruce Lietzke [ $0 0+
Craig Stadler 8 $170,000 0«

* Press Start to return to the golf course or PGA TOUR
Tent.

Y-

ELECTRONIC ARTS

I'he leaderboard lists all the players in an ongoing
tournament in order of lowest total score. The names of
human players appear in blue both in the list and separately
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below the list. Next to the name of each player is his current
score in relation to par. ‘-2 means “two under par for the
tournament.” ‘E” means “even par for the tournament.” ‘42°
means “two over par for the tournament.” Next to the “Par”
column is the “Hole” column, which indicates which hole
that particular player is on. A double dash (—) in the hole
column indicates that the player has finished the round.

* Press B to page through the list.

* Press Start to return to golf course or the PGA Tour
Tent.

TOURNEY RESULTS

The tourney results screen shows a list of all the golfers who
are currently in the tournament ranked in order of lowest

total score, which appears on the far right. Each player’s J

individual round scores are listed in order, the first round
being on the left.

v

* Press B to page through the list.

* Press Start to return to golf course or the PGA Tour
Tent.

PRACTICE PLAY

I'he Practice Round mode offers more flexibility of play
without the “money” pressure. We recommend that you play
a few practice rounds with one or more computer-controlled
pros in your party before you move on to the Tournament or

tins Challenge. That way you'll get some idea of what you'll
be up against when you decide to play for money.

* Select Practice Round from the Play menu and press A.

NUMBER OF PLAYERS

Select Number of Players

\ box appears asking you to select the number of players in
yaur golfing party. You can have up to 4 players.

* D-Pad left/right to highlight the desired number, and
then press A to confirm your choice.

41
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SELECTING PLAYERS

Next, a box appears asking you
select Player #1. This player can
a new human player, one of the
computer-controlled pros, or an
existing human player.

* D-Pad up/down to highlight
the desired player and then
press A to confirm your
choice.

|0k g | Concelg

The program allows you to save up to 16 human players. If
the roster is full, the program will indicate that there is no
more room for new players. In a practice round, you can go
ahead and play with a golfer called “Player #1”, but the

program will not retain his/her statsafter the round is over.

If you don’t want to play with ananonymous player, press
‘A’ for ‘Ok’ then ‘C’ for ‘Cancel’.

42 25

NAMING NEW PLAYERS

[ Pag  Stels Wpfeas

PLAYERS CARD a!

Name of player: BarqeretVoley

Press STRET when done

If there is room for a new player, a new players card will
appear on the screen. It’s here that you name the new player.

* D-Pad up/down to toggle through the upperand lower
case letters of the alphabet (there is a blank space after
the capital ‘Z’).

* D-Pad left/right to selgct a character and move on to the
next space.

When you're finished naming the golfer, press Start. If you
wish to play‘with an anonymous golfer and not save his
statistics, press ‘C’ at the Players Card screen. You'll play

__with a generic player (#1, #2, #3, or #4) as described on page

42. This feature is available only in Practice mode.
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TEE SELECTION + D-Pad left /right/up/down to highlight the club in bold
; type you wish to remove, and then press B.

+ D-Pad left/right/up/down to select the club in pale type
you wish to add, and then press B.

* Repeat the above process until you're satisfied with
your selection of clubs, and then Press A.

e s select a player, the program asks you to selégyy You must choose a tee-off position and a golf bag for every
off position for that FReis: Airstenr Tees are closec S, player you select before you choose your golf course.
green than Professional Tees. '
y Syt IMPORTANT: If you cancel at any time during the above process,
* IRt o R the tnes af I choice, you have to go back and start at the beginning. However, the tee
e ol con@n your selection. ‘ selection and bag selection remain the same for all the players you
_— select.
GOLF BAG -
COURSE SELECTION _
club not in
club in bag

You are allowed 13 clubs in your bag, in addition to your
putter, which you always carry. Before youadd a club to
full bag, you must remove one. The clubs in your bag a
in bold type. The clubs not in your bag appear in pale

4 7 45
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Once you've set up all the players in your party, the
selection box appears.

* D-Pad up/down/left/right to highlight the
course of your choice, then press A to confirm your
choice.

The program will start you off on hole #1, and you'll play
through all the holes on the course in sequence unless you
choose not to.

HOLE SELECTION

The great thing about Practice Round mode is that you can
it to practice individual holes you might have had trouble
with earlier. You need not play the holes in order.

* Press Start to highlight the menu bar.

The Go to menu is highlighted automatically, as well as the
Hole option.

* Press A.

SPORTS

I'he Select Hole box appears.

+ Use the D-Pad to highlight the hole of your choice, and
then press A to select the hole.

You can play a hole as many times as you wish. The scorecard
shows your most recent score on the hole.

NEW COURSE

You can change golf courses at any time dunng a practice

round. Simply select New Course from the Go fo menu. The

Select Course box appears. After you make your selection, the
program shows you an overhead view and then takes you to

the first tee of the new course. r
TAKE A MULLIGAN

In a practice round, you can take back a shot and,ﬂ it again.

+ Highlight Take a Mulligan from @ Shot Menu and
press A.

I'he program will take yMack to your previous lie. If you
wish, you can keep taking mulligans until you get back to the
tee. Note that h program will not keep statistics for holes on
which you take mulligans, except for “Longest Drive”.

PICK UP BALL

If you're doing so poorly on a hole that you're in danger of
taking more than 12 strokes (or if you're just frustrated and
want to move on) you can pick up your ball and accept a
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score of 12. The Pick up Ball option is probably most useful in
the Skins Challenge (see page 53 for more on the Skins
Challenge).

* Highlight Pick up Ball on the shot Menu and press A.

PUTTING GREEN

PGA TOUR GOLF II allows you to practice putting on any of
the 126 greens in the game. You'll find that some greens are
much more uneven than others, and it’s on these difficult
greens that you might want to practice your putting.

* Highlight Putting Green from the Play menu at the Pro
Shop or PGA Tour tent, and then press A,
* Highlight the course of your choice, and then press A.

F=aYSPORTS

I'he program will automatically take you to the 1st green. If
you want to go to a different green, pull down the Go fo menu
and select Hole as explained in the Practice Round section

above

I'he program places the ball and the cup randomly on the
preen. As soon as you sink the ball in the cup, the program
places the ball and the cup in different, randomly chosen
spots. But you need not sink the putt to change the spot of the
ball

* Select Pick up Ball from the Shot menu to change the
spot of the ball and the cup.

You may find yourself faced with a particularly challenging
putt which you're unable to sink on your first attempt. No
problem. You can practice the same putt over and over again

until you sink it.

* Select Take a Mulligan from the'Shot menu to retry a
putt.

You can also change courses just like in Practice Round.

* Select New Course from the Go to menu.
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DRIVING RANGE

Each course has its own driving range, lined by the same
trees found on the course. The driving ranges are useful in
practicing your driving accuracy, wind adjustment, power
measurement, as well as in experimenting with the Draw and
Fade meter and the Chip and Punch shots.

* Highlight Driving Range on the Play menu and
press A.

* Select a course from the Select Course Box.
If you're in the middle of a round and decide to practice your
driving, you need not select a course. The program will

automatically take you to the driving rangeat the course
you're currently playing.

50

TOURNAMENT PLAY

When you get good enough that you think you can play with
the pros (which generally means averaging par or better over
the long haul) you should enter a tournament and put your
mettle to the test. A tournament encompasses four full rounds

' holes) on the same course. Sixty professional golfers, plus
one to four players in your party, compete for hundreds of
thousands of dollars in cash. You are required to use
professional tees, and mulligans are not allowed.

MAKING THE CUT

Generally, if you shoot par or better you will make the cut.

Al the end of the first round, the top 48 players, plus all those
players tied for the lowest qualifying score, move on to the
«wcond round.
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At the end of the second round, the top 32 players, plus all
‘those tied for the lowest qualifying score, advance to the thi

“round.

Often u&e than 32 players qualify for the third round. In
such cases, the cut is reapplied at the end of the third round.
Just as before, the top 32 players, plus all those tied for the
lowest qualiq}ﬁ score, advance to the fourth round.

TS Fanags 7 [$190,000] 0+
Mark McCumber 2 | 350,000 o0+
Bruce Listzhe 0 $0 0+
Craia Stadler 8 |s170,000] 0+

While there is obviously no cut after the fourth and final
round, you can fail to finish “in the money”, which to some
feels worse than ha&see' n cut in one of the earlier rounds.
It is in the fourth round that thousands, tens of thousands,
and maybe even hundreds oﬁousands of dollars can ride

I'wo to four players compete in a Skins Challenge for cash.
I'he game is played over the course of 18 holes, withieach
hole assigned a dollar value. The value of the holul:creascs

as you play, so that the holes on the baé nine are worth

a single putt or chip. g
s

Money is apportioned out according to score at the end of

fourth round, the winner or winners taking the lion’s share. '
. much more than the holes on the front nine. The size of the

lotal purse varies from competition to'competition,
depending in part on the number of players competing.

In order to win cash, you must win skins. Each hole contains
one skin, so thete are 18 skins in all. To win a skin, you must
win a hole outright, which means you have to make a lower
score on that hole than each of the other players. The more
_ players there are, the more difficult that is to do. If two or

more players tie for the lowest score on a given hole, the skin
for that hole (which amounts to money) is carried over to the
next hole. Now you are playing for two skins. If two or more
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players tie for the lowest score on that hole, then the two
~skins are carried over to the following hole, and so on.
* Theoretically, all 18 skins could ride on the 18th hole. Now,
no one wins the 18th hole, the players return to the 1st hole,
and play continues until someone wins the remaining skin(s

Since the total sgore for the round has no bearing on who
wins and wl:;?es, when one of the players clinches a skin
on a given hole, the other players simply pick up their balls
and head to the next hole. No statistics (except Longest Dri
are kept on holes for the player(s) forced to pick up their
balls.

THE GENESIS PROS

When you're selecting/creating players at the beginning of a
game, you can choose to include one or more computer-
controlled opponents in your party.

54

* Highlight <Genesis> on the Select Player box, and
press A.

A list of the ten Genesis pros appears. These ten golfers are
based on the actual pros whose names they bear, and they're
certain to provide stiff competition even to the most seasoned
Swepa golfer. Each of the ten pros comes with a base set of stats
that indicates his strengths and weaknesses. To check out a
pro’s base stats, select the pro and begin a game. If you check
the stats of the current players, that pro’s stats will appear.
Reset his stats to see his base stats.

Tony Armour Il is a long hitter who favors a big draw.
Paul Azinger is a long hitter who uses only a slight draw.
Fred Couples is a very long hitter who uses a slight fade.
Bruce Lietzke hits a medium drive and employs a big cut.
Mark McCumber is a short hitter who uses a medium cut.
Larry Mize hits the ball short and straight.
Mark O’Meara hits the ball long anﬁight.
Joey Sindelar hits the ball long wit g a draw.

Craig Stadler hits the ball long with a big draw.
Fuzzy Zoeller his the g with a medium draw.

2
SAVE GAME
.. Ihe cartridge is designed to save only one game. When you

save a game, you “overwrite” the previously saved game and
will never be able to return to it.
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{Fft}é + Select Save Game from the Options menu, and press A.

e
The program will ask you if it's “Ok” to overwrite the
previc saved game, unless your cartridge contains no
saved game.

* Press A\t_g?éerwﬁte the previously saved game.

The game you just saved will remain saved until another
game is saved over it. g

RESTORE GAME
* Highlight Restore qun the Options menu, and
press A twice.
DELETE PLAYER &

You must be at the Pro Shop or the PGA Tour Tent to delete

players. §

* Highlight Delete Player on the Options menu, and
press A.

The program shows you a list of all the pla@ou can
delete. You cannot delete a player who is part of the current

game. If you delete a player who is part of a saved game,
player will be “undeleted” when that saved game is resto

- &ﬁ

I the saved players list is full at the time the deleted player is
undeleted”, the player at the bottom of the saved player list
will be deleted.

RESET PROS

I'he Reset Pros command resets the tournament and
individual stats for all the pros, including the Genesis Pros,
unless one of the Genesis Pros is currently involved in a
pame. You can reset the pros only from the Pro Shop or the
I"GA Tour Tent.

* Highlight Reset Pros on the Options menu, and press A
twice.

SETUP

I'he Setup menu allows you to activate and deactivate the
three “auto-view” features, the Fly-by Hole Preview, and the
llse 2 Controllers option. When an n is inactive, the
letters on the screen are dimly lit. When an option is active,
the letters are bright M

* Highlight the option of your choice and press B to

toggl off. When you've made all your selections,
press A.
* OVERHEAD (AUTO-VIEW)

When this option is active, the program automatically shows
an overhead view of the hole, provided you're more than 99
yards away from the pin.
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PGA TOUR PRESS GUIDE
iﬁALL LIE (AUTO-VIEW)
+/"'When this option is active, the program automatically shows A BRIEF HISTORY OF THE PGA TOUR

I'he beginning of professional golf in America is difficult to
discover. The names of the best golfers from the early 1800s
are for the most part lost to us. But that there were

you a pigture of your ball lie before every shot between the
tee and the green.

GREENS (AUTO-VIEW) professionals dedicated to the game, and fans who thrilled to
When this option is active, the program automatically shows Iheir outstanding play, no one doubts.

you the G rid when your ball is on the green or within

40 yards of the pin. Beginning in 1898, the historical record starts to yield more

concrete information. On New Year's Day of that year, ten
professional golfers played 36 holes of stroke play at the

Ocean County Hunt and Country Club in Lakewood, New

Jorsey and competed for a total purse of $150. Despite the /9
winter weather, a large, appreciative gallery came out to see
Val Fitzjohn defeat his brother in a sudden-death ff and
lake home $75. A

-

FLY-BY HOLE PRE&J

When this option is on, the program automatically shows an

aerial panning shot of the entire hole, ending at the tee.
i3

USE 2 CONTROLLERS'

When both controller jacks are active, Player #1 and Player

#3 use controller 1, while Player #2 j\d Player #4 use

controller 2. . Ihe New York Times provided extensive coverage of the

lournament. Shortly thereafter, tournaments began to pop up
across the country. But this was not “tour” golf, as we know it
loday, because the eve ed continuity. Interest in the
game, however, continued to grow. American professionals
were rapidly improving their games and crowds were
becoming mofe knowledgeable. When John McDermott
became the first native-born to win the U.S. Open (1911),
onthusiasm for the game expanded exponentially.

!

Helping this growth was a commercially-backed exhibition
“lour” by Englishmen Harry Vardon and Ted Ray. The two
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“raveled across the country and attracted huge crowds In the late 1930's. By the early 1940's Sam Snead's name
& whenever they stopped to play during the summer of 1913. slarted to appear in the head]mes with regularity. Then came
Howeve(, the biggest exp‘OSion of interest in the game Ben Hogal?. Byl'on N?'son, Jlmmy Demaret and others who
occurred that September. A 20-year old “local boy,"” Francis were to gain nationwide fame.
8:% dhﬁmt?: ;:a grmi?‘l:mfxom?fgoﬁtam Following w,:r.ld War I, the _TOUH became more struclqreq
front page nev:?nd a game for everyone. and as ?elewsuon ap?eared in more'anld more pf the nation’s
R homes in the late 50's and early 60's, interest in the game
The early Twenties saw the first development of what we #xploded. Once television became a player in the game, the
know as the PGA TOUR: In the winter, tournaments were uyes of the world were on golf. Tr?e exposure |n§grw millions
held on the West Coast, Texas and Florida. By the middle of lo try the game and at the same time, TV-advertising
the decade, the TOUR was offering $77,000 in total purses revenues se_mt purses soaring. The bulk of these revenues, ‘
and donating a substantial amount of money to charity. which are dlstnbt_Jted by the PGA TOUR to all co-sponsors, &
Names e Walter Hageri, Galie Sarazen and Bobby Joned have gone bgck into the purses, accounting for the tripling ot:«;g‘}’
became folk legends in a nation hungry for heroes. prize money in the last decade alone. Vﬁ
In the Thirties, the TOUR continued o grow. The PGA of B e wea e et R
: : : : yegan in , the value of tournament purses has escala
?:;ﬁm ar:;sld:;iu:dppg;t t:,?g?*eﬁ;ggi;:‘ngofwe e atan unpreoedf)nted rate. PGA TO ” ts have grown
tournaments were able to attract large crowds. It is interesting from $730,000 o 1974 10 mision t(lx'iay. and total e o 3
to look back at some figures of the time. Paul Runyan was the revenues have |nqreased $3.9 million to $140 million in
|eadmg money winner of 1934 with In contrasl, in the same time pen()d emendous gromh In revenues
1989, the top two money winners — Kite and Payne has created‘ a number of wealthy athletes, but‘more
Stewart — each earned over $1 million (see PGA Facts and importantly. allowed the PGA TOUR to vigorously
Figures, The Growth of TOUR Purses, below for more pursue its goal of being a major contributor to charitable
information). 2 oS-
; . : Charitable donations have been a hallmark of professional
E:;:;h;rtz:t?gund;gg::ﬁ::sdﬁamm:shtgul::hzﬁ&e ’ golf almost from the very beginning. The idea gf turning over
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a tournament’s after-expenses profits to charity has its origin
~in 1917. During World War |, a professional tournament was
- played to raise funds for the Red Cross. Likewise, numerous

GROWTH OF TOUR PURSES:

Ao Year No. of Events Total Purse
exhibitions were staged for the same purpose. These 1970 55 $6,751,523
practices set the mold for the TOUR and since 1938, PGA 1971 63 7,116,000
TOUR events have donated $145 million dollars to charity. Ig;g ;; ;vgg‘;-zgg
Each of the last 13 years have seen charitable contributions 1974 57 8.165.941
increase dramatically, to the point where over $100 million 1975 51 7,895,450
has been donated since 1984. The slogan, “The leading 1976 49 9,157,522
1977 48 9,688,977
money winner on the PGA TOUR is Charity,” is definitely not 1078 po 10,337 332
just a catch phrase. 1979 46 12.801 200
<’ 1980 45 13,371,786
Great athletes, knowledgeable fans, progressive and 1981 45 14,175,393 |
inventive administration, and corporate involvement have 1982 48 15,089,576 h |
made PGA golf the great garné it is today. lﬁ :g g:g?zﬁ it _'.'; |
1985 47 25,290,
— adapted from the Omcral 1990 PGA TOUR Media Guide 1986 46 25,442.2?}
1987 46 32,1
1988 47 36,959,307
1989 44 41,288,787
PGA FACTS AND FIGURES . 1990 44 46,251,831
Golfers and fans from every level of the game have a love 1991 44 49,628,203
affair with the statistics of golf. After all is said and done, the A
PRIZE MONEY DISTR

numbers tell us who won, and who didr% as well. Though
the game is played in tranquil settings, in reverent silence,
this outward calm conceals a frantic excitement caused by
large prizes that are at stake.

I'o finish a tournament “in the money” is every
professional’s goal when he starts his first round on
I'hursday morning. If he makes the 36-hole-cut, he
accomplishes his goal and has a chance for a really big
* payday. How much a golfer can make in a given
tournament depends entirely on the total purse being
offered by the tournament sponsors. Below is an

What follows are three different kinds of stal#s that we
thought you would enjoy. They are all a part of the fascmatmg
texture of the PGA TOUR.
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example of what the PGA TOUR pros are playing for
when they tee it up on Saturday and Sunday.

Total Purse: $1,500,000 (THE PLAYERS CHAMPIONSHIP
TPC at Sawgrass, Ponte Vedra, FL)

Position Prize

$288,000
172,800
105,200
75,000
62,000

s wWN =

1990 PGA TOUR STATISTICAL HIGHS/LOWS
Those with 50 rounds or more based on 192 ranked players.

Highest Average Lowest

Driving Distance 288.9 261.4 240.8
Driving Accuracy .783 672 421
Greens in Regulation .733 663 .566
Putting 1.867 1.785 1.733
Par Breakers 241 193 144
Eagles 15 5 0
Birdies 446 286 136
Scoring Average 69.59 71.18 74.85
Sand Saves .649 5058 .358

F= N\ SPORTS

“10 of the best” in PGA TOUR GOLF

Au you play the challenging TPCs, ten outstanding professionals
rom the PGA TOUR offer their insights and advice to help you
nlong. Learn from these masters and let them guide your play
ihrough the exhilarating TPC courses.

Tommy Armour Il

Tommy is the grandson of the
“Silver Scot,” winner of the
U.S. and British Opens, the
PGA Championship, charter
inductee to the PGA Hall of
Fame, and one of the great
names in the distinguished

history of golf.

Despite his lineage, a career in
golf was not automatic for
Tommy (lll). He was a fine
school-boy athlete, who
excelled in several Sports. By
the time he entered the
University of New Mexico,
however, he was committed to
golf. Tommy qualified for the

: TOUR in 1981, but then lost
his card in 1982, and couldn’t win it back for five years.

Disappointed but undaunted, Tommy used his time off the TOUR
lo practice hard and gain competitive experience in events on the
I uropean and Asian Tours. His perseverance paid off. Since he
regained his card in 1987, his career has taken off brilliantly and
he has advanced steadily up the prize money list. In 1989 he tied
for runner-up in the Kemper Open, and in 1990 he captured his
lirst TOUR victory at the Phoenix Open. Always a long ball hitter,
he again ranked in the top 10 in Driving Distance in 1990. In 1991
he finished the year with 13 eagles, putting him in 4th place in

that catagory.
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Paul Azinger

Paul honed his game with
collegiate experience at
Brevard Junior College and
Florida State University.
Following an unheralded
entry to the PGA TOUR in
1982, and a couple of
undistinguished years, Paul
began a meteoric rise to the
highest levels of the game in
1985. He improved every
aspect of his game including
his competitiveness, and in
1987, when he won three
tournaments, he was named
PGA Player-of-the-Year.

While never terribly long off
the tee, Paul is always among
the TOUR leaders in hitting
greens in regulation. His uncanny ability to select just the right
club has positioned him consistently high among the Par
Breakers, and in both 1989 and 1990 he was ranked best all-
around golfer on the TOUR.

Paul's boyish good looks and engaging manner have won him a
loyal and enthusiastic following. But it's his superiative all-around
game which has made him popular with galleries and golfing fans
everywhere. In 1990 he won the MONY. Tournament of
Champions and finished in the money in 22 out of the 26
tournaments he entered. His consistency foretells even greater
accomplishments for this fine competitor. In 1991 he finished in
the top ten twelve times in the 26 tournaments he.entered,
including a victory at the AT&T Pebble Beach National Pro-Am.
Notably, Paul Azinger has won at least one tournament each year
for the past six years, most recently the 1992 Tour
Championship.
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Fred Couples

A fine all-around athlete,

Fred was encouraged by his
father to begin competing in
junior golf events in his native
Seattle. He became an
All-American at the University
of Houston in 1978 and 1979.
After qualifying for the TOUR
in 1980, he showed that he
was equal to the challenge of
professional competition by
becoming the leading money
winner among rookies in
1981. By 1983 pros and fans
everywhere were discovering
that Fred has as much talent
as anybody on the TOUR,
He is consistently ranked in
the top 15 professionals in
scoring, eagles, putting, and
driving distance. At the 1983 Kemper Open, Fred calmly won the
now famous 5-player sudden-death playoff. In 1984, after
shooting a record-tying 64 in the first round of THE PLAYERS
Championship (TPC at Sawgrass), Fred held the lead and won
the event by one stroke.

A great shot maker who's immune to pressure: sounds like a
winner! It came as no surpfise that Fred was ranked number two
In the 1989 all-around ratings of players on the TOUR (right
behind Paul Azinger) and was also named to the Ryder Cup
leam. His vietory in the Nissan Los Angeles Open in 1990 capped
hig biggest career earnings year. 1991 was even better for Fred.
He won the St. Jude Classic on his way to eight top ten finishes.
He finished the year ranked third overall, with the best scoring
nverage (69.59) and the third best average driving distance. His
most recent achievements include winning the Verdon Trophy for
Ihe last two years, Money List Leader 1992, and earning his first
major victory with becoming the 1992 Masters Champion.
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Bruce learned the game as a
.“ boy from his older brother, a
club professional in Wichita,
Kansas. He became a fine
high school player, and won
a scholarship to the
University of Houston.

Ironically, Bruce's early start
in the game led him to give it
up. Shortly after he left
Houston in 1973, Bruce felt
he had played so much golf
that he had nothing left to
give back to the game. After
six months away from golf,
he reordered his priorities,
revived his enthusiasm, and
qualified for the PGA TOUR
in the spring of 1975.

He played well on TOUR almost from the start. Bruce's sparkling
shot-making won him a place on the Ryder Cup team (1981) and
allowed him to finish in the top twenty of the money list for the
next several years. He reasserted his exacting game in 1988,
winning the GTE Byron Nelson Classic at the TPC at Las
Colinas.

Once again in 1990 Bruce's accuracy with the driver and his
consistent fairway play helped him finish in the money in 16 of 18
tournaments he entered. 1991 was an even better year for Bruce,
statistically and financially. He was first in Greens in Regulation,
first in Total Driving, and third in Scoring Average. At this writing,
the 1992 season is still in progress, and already Bruce Lietzke
has collected more cabbage than he won in 1991.
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Mark McCumber

e Quite recently Mark has
solidified his position as one
of the finest players in the
game. In 1987 he won the
Anheuser-Busch Classic and
followed that victory with an
awe-inspiring triumph at THE
PLAYERS Championship
shooting a record-breaking
273 (15 under par).

He continued his winning
ways in 1989. In addition to
winning the Beatrice Western
Open and tying for second at
the U.S. Open, he had five
other top 10 finishes. This
amazing perf placed
him 14th on the money list and insured his selection to the Ryder
Cup team. In 1990 Mark finished in the money in 20 of 24
lournaments he entered.

Considering his consistently fine pertormanoe at THE PLAYERS
Championship, it's no surprise that Mark and his family make
their home in Ponte Ved;::grida. But Mark may have another
reason for living nearby the Tournament Players Club (TPC) at
Sawgrass: it gives him an opportunity to study and learn the
lossons of oneof the most beautiful and challenging courses in
the U.S. This'is appropriate because when Mark puts on his other
hal, he's among the best of the new generation of golf course
architects.
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As a complement to his
superbly consistent game (of
23 tournaments entered in
1990, he finished 21 of them
in the money) and in
recognition of his valuable
off-course contributions to
the game, Larry was elected
by his fellow professionals

a Player Director of the PGA
Tournament Policy Board.

Larry learned the game from
his father—a scratch
handicapper—in Augusta,
Georgia. He had a fine
collegiate career at Georgia
Tech, and qualified for the
TOUR in 1981. Six years
later he retumed to Augusta to win the Master's Tournament
(1987) with one of the most thrilling shots in recent memory.

After dropping an 8-foot birdie putt on 18 to force a tie with Greg
Norman and Seve Ballesteros, Larry birdied the second playoff
hole by holing out with a 140-foot chip shot. Norman later missed
his putt for birdie and the victory was Larry’s. This, as it
happened, was tit for tat, because Greg had beaten Larry on the
sixth hole of a fiercely contested playoff at the Kemper Open
(TPC at Avenel) in 1986.

Larry’s middle name is Hogan. Considering the feats of his
revered namesake, is Larry destined for even greater things on
the course? If 1990 is any indication, the answer is yes. He

finished the year ranked second in Driving Aceuracy and Scoring,

and had his best year on the prize money list. In 1991 he again
finished second in Driving Accuracy.
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Mark O’'Meara

Mark started to play the
game seriously in high
school in Mission Viejo,
California. Dedication and
constant improvement won
him a scholarship at Long
Beach State, where he
became an All-American in
1979. He also won the
United States Amateur
Championship that year.

-\ Mark fulfilled his boyhood
dream and qualified for the
- PGA TOUR in 1980.

: ’ Predictably, his work habits

& kN 7 4 and his talent impressed

& w everyone. He was named
TOUR Rookie-of-the-Year in
1981. Although it took him a couple of years to break away from
the pack, Mark showed in 1984 that he was destined 10 become a
great player.

=

In 1984 he finished second on the money list, putting together an
nlmost unequaled record of top three finishes (9) and forged a
well-deserved reputation for gonsistency and toughness. His
performance has led to his being named to the Ryder Cup team
in 1985 and 1989.

Mark has always been known by his peers as a great putter, a
superb tough-course player, and an avid student of all facets of
the game. As if to prove his colleagues right, Mark won (for the
second time) the difficult Pebble Beach National Pro-Am in 1990;
and earned the respect of golf course architects with his creative
advice on course design.
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Joey Sindelar

Like so many of the fine
players on the PGA TOUR,
Joey learned the game at h
father's elbow. He was six
years old when he first
picked up a club, made his
first par as an adolescent,
and never looked back.

Joey improved his game in
high school and was New
York State Junior Champion
in 1972. He realized then
that golf could help him
continue his education. He
accepted a scholarship to
Ohio State University,
following in the footsteps of
Jack Nicklaus and Ed Sne
where he was named All-American three consecutive years.

After graduating in 1981, Joey qualified for the PGA TOUR and
started impressing his peers. Many.pros think Joey plays the long
courses as well as anyone. He is often among the TOUR leaders.
in Distance Driving and Par Breakers.

Following a spectacular year in 1988, including two TOUR
victories, Joey was named to the Kirin Cup team. His earnings
that year were over half a million dollars. He probably used some
of his winnings to indulge his passion for antique golf equipment.
It's likely that his fellow pros often find themselves wishing that
he'd bronze his own clubs. In 1990 he won the Hardee's Golf
Classic.
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Craig Stadler

With a current total of eight
TOUR victories, a bushel
basket full of top ten finishes,
and the ungrudging respect
of his peers, Craig Stadler
has proven his mettle. But
Craig's amateur and early
professional history is an
instructive example of how
difficult it is for even a great
golfer to rise to the top of his
profession, and how truly
competitive the PGA TOUR
has become.

If anyone ever looked like a
“sure thing" entering the
TOUR in 1976, it was Craig.
He started playing the

game year-round with his
dad in California, at the age of five. At eighteen, he won the
World Junior Championship (1971). In 1973 he became United
Slates Amateur champion. Unanimously selected as an All-
American at the University of Southern California (1974,1975), he
was named to the Walker Cup in 1975, and then qualified for the
TOUR.

Unexpectedly, four years of mediocrity followed. He wasn't
playing badly; he just was not excelling. But in 1980 his star
began to shine, with two PGA TOUR victories. Craig won the
Kemper Openin 1981. In 1982 he notched four more victories,
Including the Master’s and his second Kemper title and finished
the year by winning the Arnold Palmer Award as the leading
money winner on the TOUR. In 1991 he won the Tour
Championship, which helped him that year to earn nearly twice as
much money as he had ever won before, finishing the season in
second place on the Money List. The rising star became a
supernova. And he keeps on shining!
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TOURNAMENT PLAYERS CLUBS [TPC]

A United States Open crown

(1984) and a Master’s - Perhaps the most exciting and original concept
Tournament title (1979) are r developed by the PGA TOUR in the past decade
enough to insure Frank Zoeller' P is the invention and construction of the

place in golf history. But one
might think that Fuzzy's

nickname was “Potential,” so
often is that word connected to
the Indiana native.

Discussing “what might have
been” in Fuzzy's case is
understandable. From the time
he qualified for the TOUR (1974
until he had back surgery
(1985), he lived with pain,
resulting from a high-school
injury. Fuzzy has never used his

- . health as an excuse, but pain
does affect performance. He won seven events on the TOUR
before 1985. In the first year after his surgery, he won three
events. Draw your own conclusions.

c Tournament Players Clubs (TPC). Sometimes

referred to as Stadium courses (due to the

amphitheater-like greens), the TPCs feature

Apectator mounds that allow fans unrestricted views of the
lvos, fairways, and greens. In fact, the 18th hole at the first
IPC at Sawgrass can accommodate more than 40,000
poople. You won't see any periscopes at an event on a
lournament Players Club course!

All TPCs are designed to host PGA TOUR or Senior PGA
IOUR events and to date the courses have been designed by
some of the top architects in the business — Pete Dye, Ron
Pritchard, and Arthur Hills, just to name a few. In addition to
securing the services of topflight designers and architects, the
PGA TOUR often assigns a Tour player to act as a consultant
1o the designer.

Fuzzy's overall play has been outstanding. He has been chosen
for three Ryder Cup teams (1979, 1983, 1985). His stylish game
combined with an open and winning personality have made him a
gallery favorite, and his fellow professionals have admired him for
more than a decade.

Serious fans and players alike love the TPC courses. The
tourses have beautiful and varied terrain making them a
spectator’s delight. Forthe pros the challenging course
layouts demand precision shot-making, courageous club
selection, and a willingness to go for broke when the situation

While he currently ranks among the PGA leaders in hitting greens :
requires.

in regulation, par breaking, and scoring average, most pros think
the strongest part of Fuzzy's game is making a difficult shot under
pressure. He used this skill at the awesome TPC at La Quinta
where he won The Skins Game against great competition in

1986. In 1991 Zoeller finished second in Total Driving and third in
Greens in Regulation.

74

= \SPORTS



La Quinta, CA

m a
RSES AND TOURNAMENTS
Tournament Players Clubs cou
4 IN PGA TOUR GOLF I
Club Architect Consultant Hosts THE PLAYERS Tournament Players Club [TPC] at
ALHAMPIONSHILYP
TPC at Sawgrass  Pete Dye The Players Sawgrass, Ponte Vedra, Florida
o —— When the PGA TOUR looking f t site for THE
Gl ) hen the went ing for a permanent site for
TPC la‘ Eagle T';:“ Arthur Hills Honda Classic PLAYERS Championship, TOUR officials saw beauty and
Coral Springs, greatness in a lush tropical setting near Ponte Vedra.
TPC of Connecticut Pete Dye Howard Twitty Canon Greater
Cromwell, CT Hartford Open I'he designer for this first “Stadium” course was the notorious
. ike Souct Pete Dye. His mission was to build a course that would challenge
;:g:;:ﬁ_mm'a P, . O the players and provide lots of spectator amenities, including
’ ; unobstructed views of the golfing action. Dye succeeded
TPC at Avenel Ed Ault Ed Sneed Kemper Open ndmirably! Three of the first nine holes are ranked among the 100
Potomac, MD Associates hardest holes in the USA. The pressure-packed precision
TPC at StarPass  Bob Cupp Craig Stadler  Northern required by almost every shot is offset perfectly by the spacious
Tucson, AZ A Telecom serenity of the course. And from well-positioned mounds and
A Tucson Open amphitheaters, the fans can see it all!
TPC at Scottsdale ~ Jay Morrish/  Jim Colbert/  Phoenix Open No detail was overlooked at Sawgrass. The 6,857 yards of the
Scottsdale, AZ Tom Weiskopf Howard Twitty course are beautifully integrated into the natural terrain rather
TPC at Piper Glen  Amold Palmer Paine Webber than being imposed on it. And the challenging combination of
Charlotte, NC e Invitational narrow fairways, extensive water hazards, and wide sand
TPC at Southwind  Ron Prichard  Hubert Green/ Federal Ex B O e s location for THE PLAYERS
Memphis, TN Fuzzy Zoeller  St. Jude Cl i a B
TPC at Von Hagge/ Independent Every year this tournament gathers the 144 best PGA TOUR
The Woodlands Bruce Devlin Insurance professionals to.pit their skills against the course, and golfing fans
The Woodlands, TX Open around the world have been thrilled by their outstanding
T - ish haw/ GTE B performances. Among the most memorable feats were Fred
lr:ggatTl;(as Sane . Jay Monis g:;gﬁ:lssoiw Nelsony(gol:ssic Couples’ astonishing 64 (8 under) in the first round of the 1984
<4 ) lournament and Mark McCumber’s incredible record-setting
TPC at PGA West, Pete Dye ‘The Skins “ victory round of 273 in 1988.
Stadium Course,
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KEMPER Tournament Players Club [TPC] at Avenel,
~= Potomac, MD

j In typical TPC fashion, the layout of the course at

OPEN  Avenel, with its natural amphitheaters and sculpted

mounds, offers spectators unobstructed views of all
the golfing action. The mixed topography of the rolling Maryland
countryside requires a player to take a substantial number of
risks to win. Like all great courses, Avenel demands good shots,
and penalizes poor ones.

Avenel is the home of the Kemper Open, the oldest continuously
corporate-sponsored golf tournament on the PGA TOUR. Since
its inception, the tournament has given Kemper the opportunity to
donate more than one million dollars to local and national
charities.

The course itself is a wonder of diversified design. At almost
7,000 yards in length, the successful player needs to control
every club in the bag to score well consistently. Elevated tees, a
variety of doglegs, tiered greens, rock runs, and water hazards
contribute to the course's exciting character. The scenic and
demanding 9th hole is typical of Avenel: It's not long, but the
elevated tee complicates the player's perspective. Ponds guard
the front and right side of the green; a bunker looms on the left. In
short, the course is a great shotmaker's paradise
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- Stadium Course at PGA West, La Quinta,
T, California

The TPC Stadium Course at La Quinta is the current
site of The Skins Game. The USGA rates it as one of
the 100 greatest golf courses in the world. That
means it's beautiful—and tough. In fact, faint-hearted hackers
simply expire here. A dizzying collection of valleys, swales,
mounds, cavernous bunkers, and merciless water hazards give a
case of the shakes to even the most courageous players.

PGA WEST

Course designer Pete Dye has created fairways that are thin
ribbons of undulating turf. Unforgiving sand, pot hole, and fairway
bunkers make every shot an adventure. Most greens are hidden
and conspiratorial. Like all great courses, it demands your best
shot every time you address the ball. If you try to play safe, you'll
get burned.

Each hole is descriptively named, and the pros know these aren’t
jokes. The signature bunkers .ofthe San Andreas Fault (16) and
Eternity (11) are duffers’ nightmares. Amen (6), ranked among
the 18 toughest pars in the USA, is thought by some to be the
hardest hole on the planet.

All fun aside, the pros and the fans love this course. The galleries
get superb views of TOUR professionals precisely executing a

magnificent variety of impossible shots that the rest of us only A
dream about. Wi

The United States Ryder Cup team will host its European
competition at PGA West, which is the chosen site of 1991 Ryder
Cup matches.
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Tournament Players Club (TPC) at Southwind,
T Memphis, Tennessee

Every year since 1958, golf fans in the Memphis

area have been treated to spectacular play at a fine

PGA TOUR event. The tournament, known through

the years as the Memphis Invitational Open, the
Danny Thomas Memphis Classic, and the St. Jude Classic, has
been sponsored by Federal Express since 1985 and is now
called the Federal Express St. Jude Classic.

The city's strong and long-standing tradition on the Tour made it
an obvious site for a Tournament Players Club, and the TPC of
Southwind was opened in March, 1988. Like all TPCs, it was
designed from the outset to accommodate a major PGA TOUR
event. Beautifully designed by Ron Pritchard, with PGA TOUR
Professionals Hubert Green and Fuzzy Zoeller serving as expert
consultants, Southwind has shown itself to be a competitive test
for championship caliber golf.

At over 7000 undulating yards in length, the course challenges
every player from tee to green. An impressive variety of doglegs,
small and/or narrow, well-bunkered gréens, and a startling
abundance of water, reward precision shot-making and
courageous play. The course is beautifully integrated into the
natural terrain and provides lots of spectator amenities, including
a variety of unobstructed views of all the golfing action. Overall
this course has a U.S.G.A. Rating of 74.8, which is the average
score of “scratch” handicappers.

Two holes on this challenging course deserve special mention.
Contrary to conventional expectation, both holes are par 3s,
which demand accuracy more than power. The 231-yard 14th is
ranked fifty-third among the toughest holes on the PGA TOUR.
The trouble begins on a monstrous elevated te@; the shot must

carry over water to a severely undulating green, which is setina

natural amphitheater. This is no walk in the park! The treacherou
11th green is an island. Modeled after the famous 17th hole of
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lhe TPC at Sawgrass, the 11th adds a pot bunker to guard the
iront edge of the green and add to the hole’s difficulty.

Southwind is an ideal venue for the Federal Express St. Jude
Classic. Federal Express’ corporate headquarters are in
Memphis and every year hundreds of the company's employees
volunteer time and service to the tournament. Since Federal

I xpress began its sponsorship of a Tour event in 1985, the purse
has more than doubled (to $1,000,000). The success of the
lournament has allowed Federal Express to contribute more than
$2,000,000 to St. Jude Hospital, the world's largest childhood
cancer research center. Once again, everyone wins at a PGA
T'OUR event.
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- Tournament Players Club (TPC) at Eagle
! Trace, Coral Springs, Florida

P In typical TPC fashion, the layout of the course at
Eagle Trace, with its natural amphitheaters enclosing
several greens, and high spectator mounds, offers
clear views of all the golfing action. Spectators never

have to strain to see their favorite pros.

The course at Eagle Trace was the second of the Players Clubs
built specifically for the PGA TOUR. Arthur Hills designed the
course in 1984, hauling in millions of cubic yards of dirt to sculpt
the massive mounds and.amphitheaters. While course design is
clearly influenced by the fitst TPC at Sawgrass, course
topography and layout@re intentionally reminiscent of the finest
of the famed Scottish links. However, the enormous quantity of
water — an elaborate system of canals which weaves through 16
of the 18 holes — makes Eagle;Trace unique. As a result, the
course demands precise iror;%s and unerring approaches —
unless your ball knows how' im!

The front nine describe a clockwise circle, and the back nine run
counter-clockwise, so that skilled playgrs are forced to change
their shots on the long holes from to draws midway through
a round. The aforementioned water hazards mean that there is
always a premium on well-placed iron shots with lots of loft. And if
these facts aren’t enough to daunt the steadiest of “down-the-
middle” golfers, keep in mind that many holgs are bounded by
tracts of untended scrub and sand called te bunkers”.
Playing from the scrub is politely known “nightmare.”

The course is a model of thoroughly diversified design, so the

successful player needs to control every club in his bag to score
consistently well. The scenic and demanding 1 le is typical
of the challenges presented by Eagle Trace. t long (a 391-
yard, par 4), but features a dizzying variety of hazards. A well
controlled left-to-right tee shot leaves the best angle to the
difficult green, a banana-shaped peninsula with water on the ri

e

ind grass bunkers on the left. The green is almost sixty yards
ong and mounded in the center. If the approach does not find the
llagstick end of the banana, the first putt will have to go through a
ong stretch of fringe.

As at Sawgrass, the four par 3's at Eagle Trace head in four
lifferent directions. These “short” holes tend to give players the
nost trouble on this unpredictable course, particularly the 7th and

the 17th. The 7th requires a tee shot almost completely over

water (and often into the wind), and presents bunkers at the back
f the green. Miss the green and par becomes a real problem.
I'he 17th is even more hazardous, with water at the front and

back of the green, and two imposing bunkers. Only the very best,
r the incredibly lucky, lower their scores on these two holes.

From 1984 to 1991, the TPC at Eagle Trace has hosted the
prestigious Honda Classic, which celebrated its 20th anniversary
in 1991, Since its inception, the tournament has provided thrilling
excitement for the fans who are constantly awed by the
magnificent golf played by the greatest champions in the game.
Most importantly the tournament has given Honda the @pportunity
lo raise more than four million dollars for South Florida charities.
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Tournament Players Club (TPC) of Scottsdale,
T Arizona

The TPC of Scottsdale, designed by Jay Morrish and

PGA TOUR professional Tom Weiskopf, was

fashioned out of completely barren desert terrain.

What was a design challenge, to say the least, has
become a starkly beautiful course, and site of the Phoenix Open,
one of the PGA TOUR's oldest and most revered tournaments.
Played since 1935, the Open has traditionally drawn the greatest
names on the!PGA TOUR to its field.

Funded by the City of Scottsdale, this TPC was the first municipal
facility to join the family of Stadium Courses. As such its design
posed unique challenges to the course architects and their player
consultants, Jim Colbert and Howard Twitty. The course had to
be sufficiently difficult to test the world’s best players in the
Phoenix Open and yet provide enjoymem to the golf-playing
residents of Scottsdale.

The designers seem to have suoceeded admirably. Professionals
and amateurs alike have to make hard choices to score well on
this course. Here are some prime examles

The 15th hole is a par five of 515 yaiﬁs — reachable in two by
every pro on the Tour (and a good many amateurs as well). But
most players (and many Tour pros) will think twice before they
blast their tee shots. A lake on the left side cautions against any
attempt to crush the ball. Even after a qcﬁiva. the second
shot will have to be as high and straight is long, because the
green sits on an island. Fifteen is an excellent three-shot par five
for the amateurs and a fine opportunity for the aggressive pros to
make 4 — or 6. .

Another subtly challenging hole is the tiny 17&;,;#’903 yards a
driveable par four for the TOUR's biggest hitters. But chances
are, few will try. With bunkers in the center of the fairway and
water to the left of the green, that 300-yard tee shot will have to°
be hit with the accuracy of a 9-iron.
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» a general rule, keep this fact in mind: When you hit the ball off

he playing area of the TPC of Scottsdale, you're basically in the
lesert. It's maintained terrain, but it's also very rugged in spots,
Jrown over with cactus, creosote bushes, brittle brush, and other

pecies of desert flora. It's a lot tougher to hit out of than it looks.

We meqlioned earlier that the Phoenix Open has featured a list of
listinguished champions — winners all. But, as with all PGA
IOUR events, charity is the biggest winner at the Open. The

lournament is sponsored by a justly famous Phoenix service

rganization known as the Thunderbirds. This organization

levotes as much time channeling Phoenix Open proceeds into
worthy activities as it spends preparing for the next tournament.

wer four and one-half million dollars have been donated to state

vide charities over the years. These funds have benefited a
variety of community groups and people in need of assistance.

ontributions in the area of sports have enabled many amateur

ithletes to represent Arizona in national and international

competition. Donations to the Arizona Recreation Center and to

& Special Olympics have helped provide therapeutic recreation
r mentally and physically challenged children.
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Electronic Arts warrants to the original purchaser of this Electronic Arts
software product that the medium on which this computer program is
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RETURNS AFTER WARRANTY - To replace defective media after the
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BULLS VS. LAKERS AND THE NBA* PLAYOFFS
New feams, new pluyus,mmajs. Reol NBA ation featuring all 16 of the actual
1991 NBA pluyoﬂm M”ﬁlﬂ with new moves including olley-oops. Free

nsive controls. Current game stats

JOHN MADDEN FOOTBALL™ 93
The best selling football videogame
now includes 28 1992-93 pro teams
based on 1992 stats, plus the 8
Greatest Ever teams and 2 All Modden
teams. John Madden's real voice reac-
{ tions, new Split Playcalling screen and
"No Huddle" offense add a whole new
dimension fo ge
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. Ron Barr, sports anchor, .
2 EA SPORTS 0
. g Emmy Award-winning reporter :
; = 4 - Ron Barr brings over 20 years of * »
e .conTTN  professional sportscasting -
I experience to EA SPORTS. His »
it network radio and television r
a credits include play-by play and}
E color commentary for the NBA
= NFL and the Olympic Games m
" Inaddition to covering EA SPORTS sporting events, Ron hosts Sports )
< Byline USA, the premiere sports falk radio show broadcast over 100 US.
~  stations and around the world on Armed Forces Radio Network and -
x  Radio New Zealand 0
< 'I‘ —
@ Barr's unmatched sports knowledge and enthusiasm afford sports fans -
- everywhere the chance to really get to know their heroes, talk to them
& directly, and discuss their views in a national forum :
l \ '
< w 7
M Tune in to SPORTS BYLINE USA -
o for the ELECTRONIC ARTS &
S SPORTS TRIVIA CONTEST for a m
5 chance to win a free EA SPORTS i
L game. Check local radio listings. >
v -
- 10:00 p.m. to 1:00a.m. E.T. m
I 9:00 p.m. to 12:00 a.m. C.T. ~
. A 8:00pm.to 11:.00 p.m M.T r
5 ELECTRONIC ARTS 7:00 p.m. to 10:00 p.m. P.T .
‘:BAH"\F'HAIL * FOOTBALL » HOCKEY » GOLF » BASEBALL * BASKETBALL +
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